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Virtual Cell Version 5.0 

Tutorial II: FRAP with Binding 

Creating a FRAP with binding BioModel 
Introduction 

This tutorial is a continuation of the first “FRAP” tutorial which created a simulation of photobleaching a 
single fluorescent species in a single cellular compartment (cytosol), where photobleaching was assumed 
to be 100% in a defined region of the cell.  Tutorial II is based on photobleaching experiments with the 
nuclear protein RAN, and adds the following additions to the scenario presented in Tutorial I. 

1. There are both fluorescently labeled exogenous and unlabeled endogenous versions of the nuclear 
protein RAN. 

2.RAN binds to an immobile component in the nucleus. 

3. Both nuclear and cytoplasmic compartments are included, and there is a flux of RAN across the nuclear 
membrane separating the two compartments 

4.Both a nonspatial and a spatial simulation are demonstrated.   

Following the Tutorial 

You can create your own BioModel and Application as you read through the tutorial or you may choose to 
load the public version of this model. To load the public BioModel tutorial, go to VCell Database> 
BioModels in the lower left panel and select Tutorials> 
Tutorial_FRAPbinding. There are two Applications (Compartmental 
and Spatial) with saved simulation results. You cannot overwrite a 
public file, so you must save a copy under your own folder in order 
to make any changes to the Biomodel. 

Defining the biological model 
Creating and Defining Compartments 

When the software starts, go to Structure Diagram at the top 
navigation bar, there you are presented with an undefined BioModel. 
Select the compartment once with the left mouse button, and then use 
the right mouse button to access the Properties menu. Scroll down to 
Add Feature and left click on it.  Click on the outer most circle and 
enter “cytosol” in the 
Structure Name text field at 
the bottom of the page in the 
Object Property box and 
press Enter. All names and 
expressions in the Virtual 
Cell are case sensitive. Be 
sure to note which case you 
use. 

Click on the middle circle, 
this will turn red, and enter in 
“NM” (Nuclear Membrane) 
into the Structure Name text 
field in the Object Property 
box at the bottom and press 
Enter. Click on the inner 
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most circle, this will turn red, and enter in “nucleus” in the Structure Name text 
field at the bottom and press Enter.  

Adding Species 

Select the species tool  and then click in the nuclear compartment once. 
Click on the Species (circle) just created to select it and access the Object 
Property box that appears at the bottom of the page where you can enter in 
Species Name and Annotation. Enter “r” in the Species Name text field. In the 
Annotation text field type in “RAN” and click Enter. 

 

Continue to use the species tool to add the following Species, using the abbreviations listed in the table. Your 
model should look similar to the picture when you have added all the species. 

You may want to save the model before proceeding with the reactions. Go to File>Save As and enter a unique 
name in the text field at the bottom, press Save. 

 

 

 

 

 

 

Defining Reactions 

Click on Reaction Diagram at the top of the navigation bar. Using 
the arrow button click on the nucleus compartment. Arrange the 
species in the box so that each is visible. You might want to use 
this image as a guide for organizing the reactions.  

Using the Reaction Connection tool   connect the species to 
each other using the picture and table as a guide on how to 
connect them. Make sure the arrows are pointing in the same 
way as the picture. Between each connection will be a reaction 
icon in yellow.  

Select the Set a Catalyst tool and connect 
the Laser species to the two reaction icons 
(bleaching 1 and bleaching 2) as shown in the 
picture. The laser is acting as a catalyst for the 
bleaching reactions.  

Once the five species are connected go back to 
the arrow button and click on the first reaction 
icon between r and rB, at the bottom there will 
be a table where you can change the Reaction 
Name and edit reaction kinetics. Alternatively, 
select Reactions in the upper left navigation or 
via the window tab. The Reactions view provides 
a  table of all created reactions. Double click in 
the Name field for each reaction to change the 

Name: Reactants: Product: 

RAN_binding r    BS rB 

bleaching 1 rf r 

bleaching 2 rfB rB 

RAN_FITC_binding rf   BS rfB 

RAN-FITC rf 

RAN_bound rB 

Binding_sites BS 

RAN_FITC_bound rfB 

Light Laser 

RAN r 

Annotation Name  
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names to those shown in the table (Be sure to note which case you use.) This name will appear when the 
reaction icon is selected.  

Select the RAN_binding reaction  In the Object Property box at the bottom Select Mass Action for the Kinetic 
Type from the selection list. Double click the Expression text field for Forward Rate Constant Kf, and enter “.002” 
and press Enter. Double click the Expression text field for Reverse Rate Constant Kr and enter “.01” and press 
Enter. 

Select the bleaching 1 reaction icon to 
access the Object Property and edit 
the reaction. Select General [μM/s] for 
the Kinetic type and enter the following 
in the Expression text field for the 
Reaction Rate equation: 

(Vmax*rf_nucleus*Laser_nucleus*((t>10.0)&&(t<10.5))) 
After press Enter to accept the equation, the Vmax will appear as a parameter. Double click the Expression text 
field for Vmax and type in “50.0”. Press Enter to accept the value. This equation defines the bleaching period 
as .5 seconds, starting after 10 seconds.  

Select bleaching 2 reaction icon to 
edit the Object Properties. Select 
General [μM/s] for the Kinetic type 
and enter the following Reaction 
Rate Equation in the Expression 
text field: 

 

(Vmax2*rfB_nucleus*Laser_nucleus*((t>10.0)&&(t<10.5))) 
 

Vmax2 will appear as a parameter. Double click the Expression text field and type in “50.0”. Press Enter to 
accept the value. This equation defines the bleaching period as .5 seconds, starting after 10 seconds.  

There are two separate bleaching reactions to account for bound and unbound RAN. 

Access the Object Property for the 
RAN_FITC_binding reaction icon. 
Select Mass Action for the Kinetic 
Type and enter “0.02” for a Forward 
Rate, Kf, and “0.1” for a Reverse 
Rate, Kr. 

Once all the reactions have been 
entered, be sure to note which case 
you use as all names and expressions 
in the Virtual Cell are case sensitive, 
save the model and proceed to Application. 

 

The FRAP binding Applications 

Introduction to Applications 
Each model developed requires an Application, which consists of a detailed description of the cellular 
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geometry, Structure Mapping, Initial Conditions, and Reaction Mapping. The geometry represents the 
morphometry of a particular cell or portion of a cell. The geometry may be captured experimentally by 
various imaging modalities such as wide field, confocal, or electron microscopy. Images can then be 
imported into the virtual Cell (see chapter 6.3 in the User Guide).Analytic geometry may be used to define 
very regular structures or symmetric cells. 

For this model you will initially create a Compartmental Application (default) where the BioModel is 
mapped to a single point. Next in the Spatial Application, you will map the BioModel to a two dimensional 
Geometry. After setting up both applications  you will be running the simulations and looking at the results. 
The results for the Compartmental model will give you an initial idea about how your model is performing. 

A Compartmental model represents a single point simulation based on the defined physiological model and 
the geometric assumptions. Structures are assigned Volume (µm3) and Surface (µm2) which is used to 
calculate the Surface to Volume Ratio and Volume Fraction. Compartmental models are not spatially 
resolved. The compartmental models are solved using nonlinear ordinary differential equations. These 
equations are generally computed within seconds. The Spatial models determine the spatial parameters 
from the geometries associated with the application. These models are solved using partial differential 
equations. 

Creating the Applications 
Compartmental Application and Geometry 

On the left navigation bar click on Application, to the right click Add New and select Deterministic. Double click 
under the Name field and enter in “compartmental”, press Enter. The Application will initialize with the Structure 
Mapping panel. The compartmental model is the default model and is automatically mapped to a single 
compartment that includes both the cytosol and the nucleus. Thus it is not necessary to create a new geometry. 

Structure Mapping 

In the Structure Mapping folder, we enter in Volume and Surface sizes for the nucleus and the Volume size of 
the parent feature, the cytosol. Select the text field in the Size column for cytosol, enter 523.33. This is the 
volume of a cell that is spherical with a 10   diameter. Then select the text field in the Size column for the 
nucleus, enter in 130.8325. Then select the text field in the Size column for NM, enter in 26.1665 for the 
Surface     .  

Initial Conditions 

Select the Specifications tab on the top navigation bar. Double click in the Initial Conditions text field for RAN (r) 
and enter an initial concentration of 5.0. Press Enter to accept the value. Do the same for RAN-FITC (rf), enter a 
value of 5.0 and for Binding sites (BS) enter a value of 20.0. 

You may want to resave your model at this point and proceed to Compartmental Simulation. This can be done 
by going to File>Save. 
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Spatial Application 

Spatial Geometry 

To create the spatial application, select the compartmental application from the 
left side navigation bar and in the right click menu, select copy. Double click on 
the new application and type in “spatial” as the new name. In the Spatial 
Application, select the Geometry Definition tab at the top. On the right hand 
side click Edit and select Analytical Equations (2D) from the drop down menu. 
You will be presented with the Geometry document which contains a single 
subdomain viewable in the Geometry Editor. Double click the Name text field 
for the subdomain and enter “cytosol”. Keep cytosol value at 1.0. 

Press Add Subdomain to create an additional subdomain. From the drop down 
menu, choose Circle for the Subdomain Shape, (0,0) for Center and 10.0 for 
Radius. 

The equation will automatically appear in Analytical Expression. Click Add 
New Subdomain to confirm it. Rename the new subdomain as “nucleus”. 

You can also choose Manual for Subdomain Shape and edit the equation 
directly in Geometry Editor. To do this double click the Value text field next 
to “nucleus” and enter the following equation that defines a circle.  

((x*x+y*y)<100.0) 
Press Enter after entering the equation. The two subdomains that you 
create will represent the cytosolic and nuclear compartments.  

Press the Edit button, at the top right corner, to access the Geometry Size 
dialog. Enter “22” in the X and Y size text fields, and enter “-11” in the X 
and Y origin text fields. Press OK to accept the values and to close the 
window. Press OK at the bottom to close the window.  

If the circle you just defined is not visible, make sure to select the nuclear 
volume and press Front to bring it in front of the cytosolic volume. The 
Front and Back buttons set the positioning of the subdomains. It is 
important to arrange the subdomains in the list so they are calculated in 
the proper order. If a subdomain is hidden or unreachable, it will not be calculated.  

Structure Mapping 

In the structure mapping folder, use the line tool  to map the 
physiology model to the geometric representation. Map nucleus to 
nucleus and cytosol to cytosol. You need to reselect the line tool each 
time you do a mapping, and you need to map from physiology to the 
geometry. The sizes associated with the geometry are used for Volume 
and Surface for each feature are taken from the resolved geometry.  

 

 

 

Initial Conditions 

Since the application was copied from the original Compartmental application, all of the values previously 
entered for initial conditions were carried over. The conditions and diffusion coefficients are entered in the 
Specifications tab of the Application. Select the Specifications tab from the left navigation bar. Enter the 
conditions for each species in the Initial Conditions text field. The Initial Conditions text field for RAN (r_nucleus) 
should contain a value of 5.0 (i.e. 5 micromoles) entered previously. With this being a spatial application 
additional values need to be entered. In the Diffusion Constant text field for RAN (r_nucleus) enter 10. 
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In the same manner (if the values 
are not already present) enter the 
same values for RAN-FITC 
(rf_nucleus) as you did for RAN: 
5.0 for an Initial Concentration 
and 10.0 for the Diffusion 
Constant. To restrict the 
expression of BS to the x,y 
coordinates of the nucleus, 
double click the Initial Condition 
text field for Binding_sites 
(BS_nucleus) enter the following 
equation: 

(20.0*((x>-3.0)&&(x<3.0)&&(y>-5.0)&&(y<5.0))) 
In the Initial Condition text field for the Laser enter in the following equation. 

((x>-5.0)&&(x<5.0)&&(y>-5.0)&&(y<5.0)) 
Reaction Mapping 

Leave the Reaction Mapping in the default settings. The reactions should all be enabled. Fast kinetics is used 
when one reaction occurs on a much faster time scale than the majority of the other reactions, and should not be 
enabled in this case.  

 

Running the FRAP Binding Compartmental 
and Spatial Simulations 
I. Compartmental Simulation and Results 

Reopen the Compartmental application from the 
application window to the left of the BioModel. Select the 
Simulation tab from the top navigation bar and press the 

New Button . In the table in the middle of the 
Simulations dialog, a simulation with a default name will 
appear. Double click the Name text field and type in your 
own simulation name.  

Press the Edit button to access the Parameters tab that lists all 
the parameters in the model and their corresponding default 
values. You can change the values and run new simulations 
without having to rebuild a new model. 

 

 

To change a default value, double click the New Value/Expression text 
field and enter in a new value. Altered values appear in red text. In this 
tutorial we will not alter any values. 

The Solver tab has various integrators that can be used. For this 
example, choose any one other than the default integrator. Then change 
the Time Step from the default of 1.0 to 0.1. The ability to change the 
Time Step default depends on the integrator choice. Press OK to accept 
the conditions and to close the dialog.  
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Make sure your simulation is still selected when you press the Run 

Simulation button to initiate the simulation .  

Your model will automatically be resaved with the new run conditions 
and the simulation will begin. The results are stores on the remote 
database server.  

Once the simulation has generated some results, the Running 
Status field will display Completed and the Results field will display 
Yes. The simulation must be selected for the Simulation Results 
button to be active. Press the Simulation Results button to open the 

Results dialog.  

You can select how you want the graph constructed by choosing the parameters of the X and Y-axes from the 
left navigation bar. The graph is interactive; put your mouse over the graph to see the coordinates for each data 
point on the curve. Press the right mouse button to access the Plot Settings dialog for additional graphing 
options.  

Export Features 

For Compartmental Applications, data can be copied from the data view  and pasted into additional 
graphing programs such as Excel. In the Graph window the user must select the desired variables using the 
Shift+click or Ctrl+click commands. Once selected the user can switch to the data view by clicking on show data 
icon in the bottom right of the window.  

Once in this view the data can be selected and copied using 
the copy command or shortcut key. See Chapter 9 of the user 
guide, Exporting Simulation Results, for more information. 

II. Spatial Simulation and Results 

Reopen the spatial application from the application frame in 
the left navigation bar. Press the Simulations tab on the top 
navigation bar and press the New button. Double click in the 
Name text field to name the simulation.  

Press the Edit button to access the Parameters, Mesh, and 
Solver tabs. Select the Mesh tab, enter “51” 
for the X and Y dimensions for the Mesh Size. 
The Geometry Size, which was defined in the 
Geometry Editor, should be listed as (22.0, 
22.0). 

Press the Solver tab to define the run 
conditions. Select the Fully-Implicit solver and 
set run times as described in the table. Press OK to accept the 
conditions and to close the dialog.  

Again, make sure your simulation is still selected when you press the 
Run Simulation button to initiate the simulation. Your model will 
automatically be resaved with the run conditions and the simulation will 
begin. The results from the simulation are automatically stores on the 
remote database server. 

Once results have been generated, press the Simulation Results 
button to access the Results dialog. The simulation must be selected 
to activate the Simulation Results button. 

Start Time: 0 

Time Step: 0.001 

End Time: 30.0 

Keep Every: 1 sec 
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Use the scroll bar, on the left side of the Results 
dialog, to change the time interval or enter a time 
in the Time text field and press Enter. You can 
drag the scroll bar or select it and then use the up 
and down arrows on your keyboard to step 
through the time points.  

You can display your results in either Gray or 
BlueRed color map. You may toggle between auto 
and manual scaling. Enter values in the Min and 
Max text fields for manual scaling. Remember to 
press Enter to accept the value and to update the 
image display. 

Use the Point tool to generate a Time 

Plot, and the Line  and Spline  tools 
to generate a Spatial Plot. 

You can choose between displaying your results as a plot and viewing the data values. Press your right 
mouse button, while over the graph, to access the Plot Settings dialog. 

 

Export Features 

Click on the Export tab to display the export features. Select the variable(s), time interval and data region(s) you 
wish to export. Files may be exported as Comma delimited ASCII files, QuickTime move files, GIF89a image 
files, Animated GIF files and several other formats. See Chapter 9 of the user guide, Exporting Simulation 
Results, for more information.  

 

 


